# Table of Contents

## Part I Welcome
- 3

## Part II Introduction
- 3
  1. Getting Started ................................................................. 6
  2. Installation ......................................................................... 6
  2. Enter your license key ......................................................... 7
  2. User Interface ................................................................... 8

## Part III Reference
- 11
  1. Menu Bar ........................................................................... 12
    - File Menu ........................................................................ 12
    - Backup ........................................................................... 12
    - Restore ........................................................................... 13
    - Exit ................................................................................ 15
    - Tools .............................................................................. 15
      - Show Reminders .......................................................... 15
      - Manage Selection Fields ............................................. 16
      - Database Connection .................................................. 16
      - Database Security ....................................................... 18
      - Export ........................................................................... 19
      - Import ........................................................................... 19
    - Help ................................................................................ 21
      - Contents ....................................................................... 21
      - Check for updates ........................................................ 21
      - Ask a question .............................................................. 22
      - About Vehicle Manager ................................................. 23
  2. Vehicles ............................................................................ 23
    - Vehicle List View ............................................................ 23
    - General ........................................................................... 24
    - Fuel Log ......................................................................... 26
      - Fuel Cost Calculator .................................................... 27
      - Partial Fill Ups ............................................................. 28
    - Service Schedule ............................................................ 29
    - Service Log ..................................................................... 31
    - Parts/Materials ................................................................. 33
    - File Attachments ............................................................. 34
  3. Service ............................................................................... 34
  4. Parts .................................................................................. 35
  5. Personnel ........................................................................... 36
  6. Vendors ............................................................................ 38
  7. Options ............................................................................. 40
  8. Reports .............................................................................. 41
    - Report Details .................................................................. 42

## Part IV System Administration
- 43

© 2019 Kaizen Software Solutions
1 Firebird Database Server ................................................................. 43
   Client Server Configuration .......................................................... 46
   Shared Database on PC ................................................................. 47
   Terminal Server Configuration ....................................................... 48
2 Troubleshoot Connections ............................................................ 48
3 Schedule Database Backup ............................................................ 52
4 Update The Client Software .......................................................... 54
5 Upgrade To Multi-User ................................................................. 55
6 Technical Details .......................................................................... 56
7 Move To A New Computer ............................................................ 57
8 Move Database To New Server ....................................................... 57
9 Advanced Configuration ............................................................... 58
   Command Line Options ............................................................... 58
   Citrix/Terminal Server Configuration ............................................ 58
   File Locations ............................................................................. 60
   Change the port number ............................................................... 61
   Multiple Databases Per Server ..................................................... 62
   Multiple Firebird Instances ......................................................... 63
   Configure Email Client ............................................................... 64
   ODBC Connections .................................................................... 65

Part V How To (Steps) ...................................................................... 68
Part VI Getting More Help ............................................................. 72
Part VII How To Buy ...................................................................... 73
Index 0
1 Welcome

Welcome to the Vehicle Manager User Guide

This User Guide is designed to serve both as an introduction and as an on-going reference for the program. If you have just started using Vehicle Manager, check out the Introduction and Getting Started links below. Experienced users will find more details in the "How To" and "Reference" section.

- Introduction
- Getting Started
- How To (Steps)
- Reference
- System Administration

2 Introduction

Vehicle Manager provides vehicle and fleet owners a central database for storing information about scheduled and completed maintenance, parts, expenses, vendors, fuel usage, and more. Service schedules may be created one service item at a time, or if you prefer, you may save a group of service items as a template, and apply the template to one or more vehicles. Service items may then be added or removed from individual vehicle schedules if needed for special cases. A reminder window will open when the program starts up if you have any upcoming or overdue service. In addition, you may run reports to display the service schedule and next due date for one or all of your vehicles. Service and expense reports may be displayed, printed, or exported to a variety of formats. Additional reports are available for your Parts List, Vendor Contacts, and Vendor Addresses.

How It Works

Vehicles are added to the system and displayed along the left side navigation list, allowing you to quickly switch the view from one vehicle to another. Common types of service may be added to the master service item list, and then service schedule templates may be created to allow you to apply complete service schedules to a vehicle all at once, saving time in data entry. After setting up the service schedules, Vehicle Manager will monitor the schedules and alert you when you open the software if any service is upcoming or overdue. Current mileage is updated automatically as new Fuel entries are added, or you may update the mileage manually by setting the Odometer reading.
Features and Benefits at a Glance

Features:

✓ Track vehicle service schedules.
✓ Track completed service and expenses.
✓ Track fuel usage.
✓ Track parts, vendors, and drivers.
✓ Print and email reports in a variety of formats (.pdf, .xls, .html, and more).

Benefits

✓ Proactively plan and manage your vehicle’s service throughout its useful life.
✓ Identify vehicles with poor mileage or routinely requiring expensive repairs.
✓ Report and summarize the data for regulatory or tax requirements.

Terminology

A brief list of terminology used in the software is listed below:

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Item</td>
<td>An individual description of service to be performed. Examples include: &quot;Change oil and filter&quot;&quot;, &quot;Rotate Tires&quot;, etc..</td>
</tr>
<tr>
<td>Service Item Type</td>
<td>The type of service item - may be &quot;Inspection&quot;, &quot;Maintenance&quot;, or &quot;Repair&quot;.</td>
</tr>
<tr>
<td>Service Item Frequency</td>
<td>How often the service should be performed. Includes a value for time and odometer. For example, &quot;Once every 3 months or 3000 miles&quot;, &quot;Once every 2 years or 15000 kilometers&quot;, etc.</td>
</tr>
</tbody>
</table>
Available units are miles, kilometers, hours, months, weeks, or years.

**Service Template**

A Service Template contains groups of service items and an associated frequency of service for each item. For example, "Change oil and filter" every 3 months or 3000 miles, which ever comes first. Several service items and schedules may be combined into a service template for different types of vehicles. For example, you may choose to add a standard set of service items for all "Large Trucks" or "Compact Cars", or "Diesel Trucks", etc. You can create a service template for each category and apply the template to each vehicle.

**Service Schedule**

A Service Schedule is the set of Service Items and associated frequency of service associated with a vehicle. The Service Schedule for a vehicle may consist of Service Items from a standard Service Template plus additional Service Items specific to the individual vehicle if needed.

**Service Log**

The Service Log is a complete history of service that has been completed for a vehicle. The Service Log includes the service item, service date, odometer reading, and any associated expenses.

**Part**

A piece or component of the vehicle or equipment tracked in the database. For example, "Alternator", "Bumper", "Windshield", etc.

**Material**

A substance or category of items used and replaced within the vehicle. For example, "Engine Oil", "Brake Fluid", "Transmission Fluid", etc.

**Manufacturer**

The name of the company which makes a product. For example, Chevrolet makes cars, AC Delco makes belts, etc.

**Vendor**

The name of the company which sells a product. For example, an Auto Parts Store.

---

**Vehicle Manager Licensing**

- Vehicle Manager licenses may be purchased online with a credit card, bank transfer, or a company purchase order. The license key is delivered via email and unlocks the 10 record limitation of the trial.
- Vehicle Manager licenses include free minor upgrades for the life of the version and major upgrades for one year. Upgrading is voluntary and not required to continue using the version of the software that has been purchased.
- Support by email is available free for both trial and licensed users (see additional support information in the next section).
- Kaizen Software Solutions also offers upgrades from one edition to another for the difference in price.

<table>
<thead>
<tr>
<th>Product</th>
<th>Number of Vehicles</th>
<th>Price (USD)*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home Edition</td>
<td>Maximum of 10 Vehicles</td>
<td>$35</td>
</tr>
</tbody>
</table>

© 2019 Kaizen Software Solutions
<table>
<thead>
<tr>
<th>Product</th>
<th>Number of Vehicles</th>
<th>Price (USD)*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Professional Edition</td>
<td>Maximum of 50 Vehicles</td>
<td>$249</td>
</tr>
<tr>
<td>Fleet Edition</td>
<td>Unlimited number of Vehicles</td>
<td>$349</td>
</tr>
<tr>
<td>Fleet Network Edition</td>
<td>Unlimited number of Vehicles</td>
<td>$699</td>
</tr>
</tbody>
</table>

*Prices in EUR and other currencies based on the exchange rate at the time of purchase.

**Vehicle Manager Support**

All Vehicle Manager support is available free by email. Additional paid support by telephone is not available at this time. This support model allows our customers around the globe to reach an appropriate expert for their specific technical, sales, or customer service question without wading through multiple levels of support and call backs. Support tickets may be submitted through the website at [www.kzsoftware.com](http://www.kzsoftware.com).

**See Also**

- [Getting Started](#)
- [User Interface](#)

Advanced users may want to skip ahead to the [Reference](#) section.

### 2.1 Getting Started

Choose from the following topics to get started:

- [Installation](#)
- [Enter your license key](#)

Or for experienced users, jump to the [Reference](#) section.

#### 2.1.1 Installation

**To install from the web:**

2. Open/Run the setup file.
3. Follow the instructions in the installation wizard to complete the installation.
Open/Run the setup file to begin the Setup Wizard, and then click the Next button. Read the license agreement, and then select “I accept the agreement” before clicking the Next button to continue. You may leave the default installation location selected, or select a different location if needed.

A shortcut will be created in the Start Menu Folder. Click the Next button to continue. Leave the checkbox checked to create a desktop icon. Click the Next button to continue. Click the Install button to begin the installation.

Also note: if your computer does not have the .NET 2 framework installed already, the installer will automatically download and install it before continuing.

Click the Finish button and wait a few moments as the software initializes the first time.

To install on a PC without internet access:

1. If the computer doesn't have the .NET 2 Framework installed, download it onto a disk, flash drive, etc. and then install it. To check, you can look at the Add/Remove programs list in Windows and look for an entry "Microsoft .NET Framework 2.0". The .NET Framework can be downloaded at the links below:
   
   ![Link to .NET Framework](https://www.microsoft.com)

2. After confirming or installing the .NET Framework, install Vehicle Manager.
3. The setup file can be downloaded to another computer and then copied to a disk, flash drive, etc, by right-clicking on the download link for the Edition you need, and then selecting 'save target as' to download the setup file. Copy this file to the other computer and run the installation wizard.
4. After opening Vehicle Manager, enter your license key.

### 2.1.2 Enter your license key

After purchasing a license key, you will need to enter it into the software to unlock the 10 record limitation imposed while in Trial mode.
1. Select the menu item **Unlock Trial Mode ➔ Enter License Key**.
2. Enter your license key into the License Key form.
3. Press the enter key or click the Ok button to save.

![License Key Form](image.png)

Note: The button will remain disabled if the key is invalid.
A Home Edition license key will only work in the Home Edition of Vehicle Manager, and a Fleet Edition license key will only work in the Fleet Edition of Vehicle Manager. If you have purchased a license key for a different edition of the software than what you have installed, you will need to install the matching edition in order to use your license key.

### 2.2 User Interface

This section describes the common user interface elements used throughout the program.

**The Main Window**

The Vehicle Manager main window is divided into 4 main areas: the Menu Bar, the Navigation Buttons, the Vehicle List, and the Sub Tabs.
The Menu Bar

The menu bar contains the File, Tools, and Help menu items.

More information on each of these menu items is available by going to the Reference section here.

The Navigation Buttons

The Navigation buttons allow you to easily switch between the Vehicles, Service, Parts, Personnel, Vendors, Options, Reports and Help sections.
More information on each of these tabs is available by going to the Reference section here.

**The Vehicle List**

The vehicle list view displays the list of vehicles in the database.

- Search for a vehicle using the search box at the top of the list.
- Or select a vehicle by clicking on the row containing the vehicle.
- Sort the data by any of the columns in the list view by clicking on the header for that column. Click again to reverse the sort order.
- The Green/Yellow/Red status indicator provides the overall service status for the vehicle based on the service schedule.

**Sub Tabs**

The main Vehicle screen contains the following Sub tabs: General, Fuel Log, Service Schedule, Service Log, and Parts/Materials.

**Date Fields**

The date fields on the data entry forms contain a calendar field to ensure that the date gets entered into the database in the correct format. This field has several features:

- To update the entry using the keyboard:
  - Use the left and right arrows on the keyboard to move back and forth within the field.
  - Use the up and down arrows on the keyboard to change the values, or type the values in using the number keys on the keyboard.
  - Use the tab key to exit the date field, moving the cursor to the next field on the form.

- To update the entry using the mouse:
  - Click the down arrow at the right of the field to drop down the calendar and select a new date.
  - Click the left and right buttons to change the month.
o Click the name of the month displayed at the top of the calendar pop-up to select a different month.
o Click the year displayed at the top of the calendar pop-up to select a different year.
o Click the "Today" area near the bottom of the calendar to set the date to Today's date.

**Picture Fields**

Picture fields allow you to add a picture to a record. This field is available on the Vehicle and the Personnel forms.

Click the Change Picture link to select a picture file from your computer. Picture files may be .jpg, .jpeg, .gif, .tif, .bmp, or .png.
Adding a new picture will overwrite the current picture.
Click the Clear link to remove a picture.

## 3 Reference

The **Reference** section provides a detailed explanation of each area of Vehicle Manager. Click on a link below for details about the item.

- **Menu Bar**
  - File
  - Tools
  - Help
- **Vehicles**
  - Vehicles List View
  - General
  - Fuel Log
  - Service Schedule
  - Service Log
  - Parts/Materials
- **Personnel**
- **Vendors**
- **Reports**
3.1 Menu Bar

The menu bar is located at the top of the main window. Click on any of the menu items listed below for more information.

**Menu Bar Items**

- **File**
- **Tools**
- **Help**

3.1.1 File Menu

The File menu contains the menu items listed below. Click on a link below for complete details.

**File Menu Items**

- **Backup**
- **Restore**
- **Exit**

3.1.1.1 Backup

The Backup function creates a compressed data file containing a full backup of the database. This feature allows you to create a backup manually at any time. If you are using the Enterprise Edition, you may also schedule an automatic backup.

**Steps to backup a database**

1. Select File → Backup to open the Backup database dialog box.

![Backup Database Dialog](image)

2. Click the Browse button to select a location for the file, and enter the name of the file to save.
3. Click the “Backup” button to perform the backup.
4. Dismiss the confirmation box. If the Backup operation fails for any reason, close the application and then reopen it and perform the Backup operation again.

**Key Points:**
- The backup file is a compressed snapshot of the database. It cannot be opened directly. To restore the database from the backup file, use the menu option: File \(\rightarrow\) Restore.
- Be sure to store the backup file on an external or remote drive so it will be available in case your hard drive crashes and becomes inaccessible. If possible, copy the file to a network server that is backed up.
- If you are using the Enterprise Edition with a remote database server, ask your server administrator to schedule a nightly backup using these instructions.
- It’s a good practice to periodically audit the backup and restore operation. To perform the audit, test the restore operation on a different database to ensure that the backup file can be restored properly. Note that the restore operation will completely overwrite the target database, so use a local test database on another computer which is not connected to your live database to ensure that no changes are made to the live database when performing the audit.

### 3.1.1.2 Restore

The Restore function restores the data from a compressed backup file over an existing database. This operation will completely overwrite the current database with the contents of the backup file.

To ensure a successful restore operation, it is important that no one else is using the database and no one attempts to log into the database during the restore operation.

**Steps to restore a database**

1. Select File \(\rightarrow\) Restore to open the Restore database dialog box.
2. Click the Browse button and select a backup file that you have created earlier.
3. Click the Restore button and click "Yes" when asked if you want to proceed. Note that this will completely overwrite your current database with the data from the backup file.

4. Wait while the database is restored. This may take several minutes for a large database. Do not interrupt the Restore operation, or the restored database may be corrupt.
5. Dismiss the confirmation box. If the restore operation fails for any reason, close the application and then reopen it and perform the Restore operation again.

---

**confirmation**

*Vehicle Manager Fleet Edition with network support*

**Restore from backup file**

Select the backup file:

`C:\Documents and Settings\Admin\Desktop\backup.vbl`  
Browse...

[Restore]  [Cancel]

**Confirmation**

*Vehicle Manager Fleet Edition with network support*

**Overwrite database?**

This process will overwrite your existing database with the data in the backup file. Do you want to continue?

[Yes]  [No]

---

**Key Points**

- It is critical that no one else is logged into the database or attempts to login to the database while the restore process is running.
- The restore process may take several minutes to complete, and it should not be interrupted.
- The restore process will completely overwrite the database with the contents of the backup file. Any data entered since the backup file was created will be overwritten.
- It's a good practice to periodically audit the backup and restore operation. To perform the audit, test the restore operation on a different database to ensure that the backup file can be restored properly. Note that the restore operation will completely overwrite the target database, so use a local test database.
database on another computer which is not connected to your live database to ensure that no changes are made to the live database when performing the audit.

3.1.3 Exit

Select File → Exit to close the application. This has the same effect as clicking the 'X' in the upper right corner.

3.1.2 Tools

The Tools menu contains the menu items listed below. Click a link below for complete details.

**Tools Menu Items**

- Show Reminders
- Manage Selection Fields
- Database Connection (for Network Edition only)
- Database Security
- Export
- Import

3.1.2.1 Show Reminders

The Service Reminders window displays a list of all upcoming or overdue service based on the service schedules. This window will pop up when opening Vehicle Manager if there are any reminders coming up. You may also open this window at any time by selecting the menu item Tools --> Show Reminders.

![Reminders Window](image)

A **Red status** indicator means that the service is currently Overdue.

A **Yellow status** indicator is a reminder that the service will be due soon (based on the "Show
Reminder” settings for the service schedule).

The **Dismiss Reminder** button will make the selected reminder(s) go away; however, the service will still be due based on the schedule. This is used to remove the reminder from the pop up window without losing track of the required service.

The **Skip Service** button is used to skip one scheduled service for the selected reminder(s). For example, if you have a Weekly Inspection scheduled and will not be able to complete the service this week, you may choose to "Skip Service". The Service Schedule will be updated with the new due date/odometer reading based on the recurring schedule settings.

You may also sort the list by clicking on a column header.

### 3.1.2.2 Manage Selection Fields

The **Manage Selection Fields** menu opens the dialog box which allows you to add, edit, delete, and reorder the selection field values.

![Manage Selection Fields Dialog](image)

**Steps to add/edit/delete selection values**

1. Select **Tools → Manage Selection Fields** to open the dialog box.
2. Select a Selection Field from the list on the left.
3. Use the buttons on the right to add, edit, delete, or reorder the selection values.

### 3.1.2.3 Database Connection

The **Database Connection** menu (Fleet Network Edition only) opens the dialog box which allows you to switch between a local database and a remote database.
Database Connection Dialog

**Connect to single user local database file (file path):**
Select this option to connect to the local database file. This file is located in the Windows All Users Application Data directory by default.

**Connect to multi-user database server (Server name or IP Address):**
Select this option to connect to a database on a server. Enter the name of the server or the IP Address that your server administrator has provided. The server must have the Firebird database component installed on it. The connection will use TCP/IP. You cannot connect using a shared folder or UNC path. For more information, see the [Database Server Configuration Page](#).

**Connection Test**
Click the "Test Connection" button to verify that your connection is successful.

**Check Firebird Version**
Click the "Check Firebird Version" button to determine the version of Firebird database in use.

**Advanced**
**DB Port:**
Set the port number that the Firebird database server is listening on. The default value is 3050. This value must match the "RemoteServicePort" value set on the server in the firebird.conf file. Note: the Firebird service must be restarted after making changes to the firebird.conf file. Also, be sure to update the windows firewall to allow TCP connections on the specified port number.
**DB Name (Alias):**
Set the name of the database alias defined in the aliases.conf file on the server. The default value is: "VehicleManager" (no quotes or spaces). Note: the Firebird service must be restarted after making changes to the aliases.conf file.

**SYSDBA Password:**
Enter the value of the Firebird SYSDBA password. This value will be "masterkey" by default, and it can only be changed on the server by your database administrator. If you receive a message which indicates the Login Name / Password was not recognized, try using the default password "masterkey". If this does not work, contact your database server administrator.

### 3.1.2.4 Database Security

Set a password to modify the database using the **Database Security** dialog. After a database password has been set, a password prompt will pop-up when opening the software. The user may enter a password to open the software and be able to make changes, or they may open it as "read-only" to view the data without being able to make changes to it.

![Database Security Dialog](image)

**Steps To Set A Database Password:**

1. Open the Database Security Dialog (menu item Tools --> Database Security)
2. Enter the password in the space provided.
3. Click the Ok button.
4. Enter the new password again to confirm it.
5. Click the Ok button to complete the change.

Check the **Remember password on this computer** checkbox if you want the password to be automatically filled in for you on the computer you are using.

Check the **Automatically open in read-only mode on this computer** checkbox if you want the software to open in read-only mode automatically. When this is checked, the software will open without the password prompt pop-up window.

Click the **Clear Password** button to remove the password from the database. This will allow all users to open and use the software without entering a password. You can only clear the password if you know the current password.
3.1.2.5 Export

The Export menu item opens the Export Data dialog box with options for exporting data out of the database.

Steps to Export Data

1. Select the menu option Tools --> Export to open the Export Data dialog box.
2. **Record Type**: Select the type of records to export.
3. **Data Format**: Select the format of the file to create.
4. **File Name**: Click the Browse button and select a location and file name where the data file will be created.
5. Click the Export button to export the data.

3.1.2.6 Import

The Import menu allows you to import the Vehicle, Fuel Log, Vendor, Personnel, and Parts data from a .csv file. Existing records will be updated (if the Update checkbox is checked on the Import tab), or if a matching record cannot be found, the record will be added as a new record.

Records will be either Updated or Added New based on the following:

- **Update Vehicle Record**: If an existing Vehicle record has a matching VIN or Vehicle Number in the source file, and the fields have been mapped on the Field Mappings tab, the record will be updated with any changes.
- **Update Fuel Log Record**: If an existing Fuel Log record has a matching Fill Up Date and End Odometer in the source file, and the fields have been mapped on the Field Mappings tab, the record will be updated with any changes.
- **Update Personnel Record**: If an existing Personnel record has a matching Personnel Number or First and Last Name in the source file, and the fields have been mapped on the Field Mappings tab, the existing record will be updated with any changes.
• **Update Vendor Record:**  
  If an existing Vendor record has a matching Company Name in the source file, and the fields have been mapped on the Field Mappings tab, the existing record will be updated with any changes.

• **Update Part Record:**  
  If an existing Part record has a matching Part Number in the source file, and the fields have been mapped on the Field Mappings tab, the existing record will be updated with any changes.

• **New Vehicle, Fuel Log, Vendor, Personnel, or Parts Record:**  
  If a matching record is not found, a **New** record will be added to the database.

You may import a source file which contains all or only some of the data fields.

**Important:** Be sure to test out your import files on a test database and/or backup your production database prior to importing the data. It is a good idea to develop a repeatable and consistent process for creating your import file if you plan to perform the operation on a regular basis.

**Data source tab:**  
The Data Source tab is the first tab on the Import Wizard accessed using the menu option Tools --> Import. This tab allows you to select an import file and configure the settings to match the import file format.

**Import file**

The import file is the .csv file which contains the data to import. For example, if you have a list of personnel in an Excel spreadsheet, you can save the spreadsheet as a .csv file using the File Save As command in Excel, and then import the personnel records rather than entering them all manually.

**Malformed .csv File Message:**  
MS Excel will sometimes leave out the ending comma if the last column in the file contains data in only some of the rows. For example, if you have a Notes column in the last column of your file, and only a few of the rows have any data in the Notes field, the file may not get saved in a proper .csv format with an ending comma for the empty columns. In this case, you may want to delete the last column and then resave the file for import, or ensure that each row contains data in that column in order for the import file to be saved in a valid .csv format.

You may need to remove any unused or empty columns in your source file to avoid creating a malformed .csv file.

**File format**

**Field Delimiter:** For .csv files, the field delimiter will be a comma. This is the character which separates the fields in the file.

**Text Qualifier:** The Text Qualifier is used to surround the values for each field. For example, if you have a field with a comma in it, you will need to include the value in quotes so that it is recognized correctly.

**First row contains column names:** Check this box if the first row of your import file contains file names.

**Data preview**

The Data preview section displays the first few rows of the import file so you can check to see if the settings are correct.
Field mapping tab:
This tab provides options for mapping the data from the fields in your source file to the fields in the Vehicle Manager database. The Source Fields are listed in the column on the left side. For each field that you want to map to a Vehicle Manager field, click in the area to the right of the field and then select a destination Asset Manager field to map it to.

Source Field: The source field is the name of the field from the import file.
Vehicle Manager Field: The Vehicle Manager Field is the corresponding field in Vehicle Manager to map the source field to.

Import tab:
Click the "Import" button on this tab to import the data into the database. A summary of the import results will be provided in the Import Summary section after the import process is completed.

Troubleshooting Malformed csv files:
The "Save As file type" feature in Excel will sometimes create a malformed csv file which cannot be used in the import process; however, you can try exporting to a unicode text file instead. The Unicode text option produces an output similar to tab-delimited text, but it allows for the inclusion of non-ASCII characters such as Chinese, Arabic or Hebrew letters, which otherwise may appear as question marks.

To convert from an Excel file to a tab delimited text file:
2. When using this option, be sure to select the .txt file instead of the .csv file when you select the import source in Training Manager.
3. Also, change the field delimiter to a tab instead of a comma on the Data Source tab.

3.1.3 Help
The Help menu contains the menu items listed below. Click a link below for complete details.

Help Menu Items
- Contents
- Check for updates
- Ask a question/Send feedback
- About Vehicle Manager

3.1.3.1 Contents
The Contents menu opens this User Guide.

3.1.3.2 Check for updates
The Check for updates menu initiates a connection to our update server to compare the version of the software you are using with the current version of the software. A pop-up message will notify you to let you know whether you are using the current version of the software. If you are using an older version, you will be provided with an option to download the update. To install the update, download the setup file when prompted, and click Open or Run to update your software. Your database will remain intact, so you will not lose the data that has been previously entered.
Some updates may require a change to the database schema after the software has been updated. In these cases, you will be notified the first time you open the new version that it needs to update the database. If you receive this message, it is important that no one else has the software open before you continue, and Vehicle Manager will automatically update the database schema for use with the current version of the software.

In a multi-user environment, it is important that all users have the same version of the software installed. Users with an older version of the software may receive an error message when connected to a database which has been updated.

If a corporate firewall prevents you from connecting to our update server, you may also download the software from the downloads page on our website. This is the same software which can be downloaded through the Check for updates menu.

For information about the changes that have occurred, check the Product Updates section on our blog.

3.1.3.3 Ask a question

The menu option Ask a question / Send feedback will open a dialog box you can use to contact Support. You may use this form to contact us about a:

- Question
- Enhancement Request
- Bug Report
- Other Feedback
Messages sent through this feedback form will be sent to our tracking system and then forwarded to Sales, Support, or Customer Service depending on the nature of the feedback. See additional Contact Information here.

3.1.3.4 About Vehicle Manager

The **About Vehicle Manager** menu item opens a dialog box with information about the currently installed Vehicle Manager software, including the version number.

3.2 Vehicles

Vehicle records contain the details for specific Vehicles. For complete details, see the following sections:

- Vehicles List View
- General
- Fuel Log
- Service Schedule
- Service Log
- Parts/Materials

3.2.1 Vehicle List View

The **Vehicles list view** displays the list of Vehicles that have been entered into the database. It is located along the left side of the main window.

**Show Active:**
Select from the drop-down list to display Active, Inactive, or All vehicles in the database.

**Search:**
Enter a few characters of the Vehicle name or number in the Search box near the upper right to filter the list.

**Sorting:**
Click on a column header to sort the data by that column. Click again to re-sort the column in the opposite direction. To sort the

**Status:**
The Green/Yellow/Red status indicator represents the overall service status for each vehicle as follows:

- **Green:** All Service is up to date.
- **Yellow:** One or more service schedules is Upcoming based on the "Reminder" settings, but none are Overdue.
- **Red:** One or more service schedules is Overdue.
3.2.2 General

The **General** tab is where you enter the Specifications and descriptive information about the vehicle.

<table>
<thead>
<tr>
<th>Field/Form Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Button: New</td>
<td>Click the New button to clear all the fields and begin adding the information for a new vehicle. Be sure to save any previous work before starting a new vehicle.</td>
</tr>
<tr>
<td>Button: Save</td>
<td>Click the Save button to save the changes you have made to the information on the General tab.</td>
</tr>
<tr>
<td>Button: Delete</td>
<td>Click the Delete button to remove the current vehicle from the database. This is a permanent delete, and it will remove the vehicle and all of the related service from the database.</td>
</tr>
<tr>
<td>Button: Set Inactive</td>
<td>Click the &quot;Set Inactive&quot; button to set the Status of the current vehicle to &quot;Inactive&quot;. The vehicle and all related data will remain in the system; however,</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Model Year</td>
<td>Enter the model year of the vehicle. This will appear on reports and in the list view as part of the vehicle description.</td>
</tr>
<tr>
<td>Odometer</td>
<td>Enter the current odometer reading and select the units (Miles, Kilometers, or Hours). This value will be automatically updated when adding new Fuel records, or you may updated manually on this screen.</td>
</tr>
<tr>
<td>Model</td>
<td>Enter the Model of the vehicle. This will appear on reports and in the list view as part of the vehicle description.</td>
</tr>
<tr>
<td>Vehicle #</td>
<td>You may enter a number to identify this vehicle. Use leading zeros if you would like to order the list by vehicle number (eg. 01, 02, etc.)</td>
</tr>
<tr>
<td>Color</td>
<td>Enter the exterior color of the vehicle.</td>
</tr>
<tr>
<td>Driver/Operator</td>
<td>Select the name of the driver or operator. This list is populated with the names from the Personnel section. This field is available in the Pro and Fleet Editions only.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the Type of record (Van, Truck, etc.). You may add additional types using the menu option Tools --&gt; Manage Selection Fields, or by clicking on the Type label.</td>
</tr>
<tr>
<td>Department</td>
<td>Select the Department that this vehicle or equipment belongs to. You may add additional Departments using the menu option Tools --&gt; Manage Selection Fields, or by clicking on the Department label.</td>
</tr>
<tr>
<td>Picture</td>
<td>Click &quot;Change Picture&quot; and then select a picture from your computer to change the picture that is displayed. Click &quot;Clear&quot; to remove the picture.</td>
</tr>
<tr>
<td>Plate/Tag #</td>
<td>Enter the license plate or tag number.</td>
</tr>
<tr>
<td>Renewal</td>
<td>Enter the renewal date for the license or registration.</td>
</tr>
<tr>
<td>Engine</td>
<td>Enter the size/type of the engine.</td>
</tr>
<tr>
<td>Transmission</td>
<td>Enter the type of transmission.</td>
</tr>
<tr>
<td>Tire Size</td>
<td>Enter the tire size.</td>
</tr>
<tr>
<td>Insurance Company</td>
<td>Enter the name of the insurance company.</td>
</tr>
<tr>
<td>Account #</td>
<td>Enter the account number for the insurance.</td>
</tr>
<tr>
<td>Premium</td>
<td>Enter the amount of the premium payment for the insurance.</td>
</tr>
<tr>
<td>Due</td>
<td>Enter the date when the premium payment is due.</td>
</tr>
<tr>
<td>Notes</td>
<td>Enter any miscellaneous notes about the vehicle.</td>
</tr>
</tbody>
</table>
### 3.2.3 Fuel Log

The **Fuel Log** tab contains the complete fuel log history for your vehicle. The summary total fuel cost and average fuel efficiency is displayed at the top. You may also print reports covering specific date ranges in the Reports section. Note that the Units of Measure for Currency, Volume, and Fuel Efficiency can be managed on the **Options** screen. The Odometer units can be set for each vehicle on the **General** tab.

<table>
<thead>
<tr>
<th>Date</th>
<th>Ending Odometer</th>
<th>Miles</th>
<th>US Gallons</th>
<th>Cost</th>
<th>US MPG</th>
</tr>
</thead>
<tbody>
<tr>
<td>7/8/2009</td>
<td>270</td>
<td>270</td>
<td>13.2</td>
<td>$28.75</td>
<td>20.5</td>
</tr>
<tr>
<td>8/8/2009</td>
<td>549</td>
<td>279</td>
<td>12.7</td>
<td>$24.90</td>
<td>22.0</td>
</tr>
<tr>
<td>9/8/2009</td>
<td>624</td>
<td>284</td>
<td>13.4</td>
<td>$25.65</td>
<td>21.2</td>
</tr>
<tr>
<td>10/8/2009</td>
<td>1342</td>
<td>262</td>
<td>12.9</td>
<td>$26.56</td>
<td>20.3</td>
</tr>
</tbody>
</table>

**Field/Form Element** | **Description**
--- | ---
Button: New | Click the New button when you are ready to add a new fuel entry for the selected vehicle.
Button: Save | Click the Save button to save the fuel log entry.
Button: Delete | Click the Delete button to delete the selected fuel log entry.
### 3.2.3.1 Fuel Cost Calculator

The Fuel Cost Calculator allows you to calculate the Total Cost based on (Total Volume) X (Price per unit). This can be used if you have purchased bulk fuel at a specific price per unit, and want to enter the Total Volume only and have the Total Cost calculated for you.
After clicking the calculator button, you may enter a price per unit, or use the default value which appears in the form. If the Total Cost and Total Volume have already been entered, the price per unit will be set to Total Cost divided by Total Volume. Otherwise, a default value will be set as follows:

1. If a previous entry for the selected fuel type has been entered, the price per unit will be set to the most recently used value for that fuel type across all vehicles.
2. Or, if the fuel type has not been selected or there are no other entries for that fuel type, the price per unit will be set to the most recently used value for the currently selected vehicle.

### 3.2.3.2 Partial Fill Ups

The data entry area on the Fuel Log tab includes a checkbox for "Complete Fill Up". This checkbox is used to indicate whether the fill up is Complete or Partial. The fuel efficiency will not be calculated for a partial fill up, since it is unknown how much fuel was used for the distance driven; however, the fuel volume and the odometer change values will be included in the Fuel Efficiency calculation for the next fill up and for the overall fuel efficiency.

Example "miles per gallon" fuel efficiency calculations with partial fill ups:

<table>
<thead>
<tr>
<th>Date:</th>
<th>Begin Odometer</th>
<th>End Odometer</th>
<th>Odometer Change</th>
<th>Volume</th>
<th>Complete</th>
<th>Fuel Efficiency (MPG)</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>10/15/2012</td>
<td>0</td>
<td>100</td>
<td>100 Miles</td>
<td>10 Gallons</td>
<td>Yes</td>
<td>10 MPG</td>
<td>MPG = 100 / 10 MPG = 10</td>
</tr>
<tr>
<td>10/31/2012</td>
<td>100</td>
<td>200</td>
<td>100 Miles</td>
<td>5 Gallons</td>
<td><em>No</em></td>
<td>N/A</td>
<td>The fuel efficiency is not calculated</td>
</tr>
<tr>
<td>Date</td>
<td>Volume</td>
<td>Miles</td>
<td>Gallons</td>
<td>Status</td>
<td>Efficiency</td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td>---------</td>
<td>-------</td>
<td>---------</td>
<td>--------</td>
<td>------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11/15/2012</td>
<td>200</td>
<td>300</td>
<td>100</td>
<td>Yes</td>
<td>10 MPG</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The fuel efficiency for this entry includes the volume and odometer change from the previous partial fill.

\[
MPG = \frac{\text{Total Odometer Change}}{\text{Total Volume of fuel used}}
\]

\[
MPG = \frac{100 + 100}{15 + 5} = \frac{200}{20} = 10
\]

Overall Fuel Efficiency = \frac{300}{30} = 10

### 3.2.4 Service Schedule

The Service Schedule tab displays a complete listing of service that has been scheduled for the selected vehicle. A color-coded status indicator identifies whether the service is Up to date (Green), Coming soon (Yellow), or Overdue (Red).
### Toolbar Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Click the New button to clear the fields and begin a new Service Schedule record.</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save button to Save the current record.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click the Delete button to Delete the current record.</td>
</tr>
<tr>
<td>Complete</td>
<td>Click the Complete button to mark the currently selected service schedule Complete. This will automatically add an entry to the Service Log.</td>
</tr>
<tr>
<td>Report</td>
<td>Click the Report button to open a printable report of the scheduled service.</td>
</tr>
<tr>
<td>Export</td>
<td>Click the Export button to export the service schedule for this vehicle to a .csv file.</td>
</tr>
</tbody>
</table>
Fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Item</td>
<td>Select an existing service item or enter a new one.</td>
</tr>
<tr>
<td>Repeat Every</td>
<td>If this is a recurring schedule, check the checkbox, and then enter/select the fields to define how often the schedule should be repeated.</td>
</tr>
<tr>
<td>Next Due</td>
<td>The Next due fields will be calculated based on the service schedule (if set). You may also override the values if needed.</td>
</tr>
<tr>
<td>Show Reminder</td>
<td>You may set the criteria for when a reminder is shown in the &quot;Show Reminder&quot; section. This will determine when the Upcoming (Yellow) status is applied to the schedule.</td>
</tr>
<tr>
<td>Notes</td>
<td>Select the Notes tab to add more information about this service schedule entry. For example, this is a good place to record any special tools required or hints, procedures, etc.</td>
</tr>
</tbody>
</table>

3.2.5 Service Log

The Service Log displays the list of service that has been completed for the selected vehicle. The Total Expenses is displayed in the upper right corner. This is the sum total of all Service Log Expenses that have been entered for the selected vehicle.
### Toolbar

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Click the New button to add a new Service Log entry.</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save button to save the current Service Log entry.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click the Delete button to Delete the current Service Log entry.</td>
</tr>
<tr>
<td>Report</td>
<td>Click the Report button to display a report of service log entries for the currently selected vehicle.</td>
</tr>
<tr>
<td>Export</td>
<td>Click the Export button to export all service log entries for the currently selected vehicle.</td>
</tr>
<tr>
<td>Add Expense (parts, labor, tax)</td>
<td>Click the Add Expense button to add a Part, Labor,</td>
</tr>
</tbody>
</table>
or Tax expense related to the current Service Log entry.

### Fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Item</td>
<td>The Service Item field contains values from the Master List of Service Items. You may select a value from the list, or place the cursor in the field and begin typing to add a new value to the list.</td>
</tr>
<tr>
<td>Service Date</td>
<td>The Service Date is the date when the service was performed.</td>
</tr>
<tr>
<td>Odometer</td>
<td>The Odometer field is the value of the odometer when the service was performed.</td>
</tr>
<tr>
<td>Notes</td>
<td>Miscellaneous notes may be entered in the Notes field.</td>
</tr>
<tr>
<td>Expense Grid</td>
<td>The Expense grid contains a line item listing of expenses for each service log entry.</td>
</tr>
</tbody>
</table>

The **Expense Form** is opened by selecting a row on the Service Log and then clicking on the **Add Expense** link. Select the type of expense on the left (Parts, Materials, Labor, or Tax), and then fill in the Expense information. When finished filling in the information, click the Ok button to add the expense to the service entry.

**Expense Form**

3.2.6 **Parts/Materials**

The **Parts/Materials** tab displays a list of parts and materials that have been used on a specific vehicle. This list is a sub-set of the **Main Parts List**. New records will be automatically added to this tab when a
Part Expense is added to the Service Log.

3.2.7 File Attachments

The File Attachments tab provides a place to store file attachments for your vehicles. Files added here will be stored in the database and included when creating backups.

3.3 Service

The Service screen is where you can manage the master list of service items and service templates. Service Items are available for selection from the drop-down lists on the Service Log and Service Schedule tabs. Service Templates are used to create a group of Service Items which can be applied all at once to a Service Schedule.

This grid displays the parts and materials for the selected vehicle. Parts that have been used for Expenses on the Service Log are automatically added to this list.
3.4 Parts

The Parts screen displays all of the parts that have been used on any vehicle. You can keep track of the Quantity of parts on hand by updating the value when new parts are purchased. When parts are used as part of an Expense on the Service Log, the Quantity used will be automatically deducted on the Parts list.
3.5 Personnel

The **Personnel List View** displays a list of the personnel records that have been added to the database. The Personnel listed here will be available for selection in the Driver/Operator field for the Vehicle on the General tab.
# Toolbar Buttons

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Personnel</td>
<td>Opens a new Personnel form. Use this form to add new employees or trainers to the database.</td>
</tr>
<tr>
<td>Edit</td>
<td>Opens the currently selected (highlighted row) personnel.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the currently selected personnel.</td>
</tr>
<tr>
<td>Export</td>
<td>Opens the Export options dialog box to allow you to export the list of Personnel to a .csv file.</td>
</tr>
</tbody>
</table>

## Fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personnel #</td>
<td>Enter the Personnel Number for the individual.</td>
</tr>
<tr>
<td>Hire Date</td>
<td>Enter the date when the individual was hired.</td>
</tr>
<tr>
<td>Status</td>
<td>Select Active or Inactive for the individual's current employment status.</td>
</tr>
<tr>
<td>Last Name</td>
<td>Enter the Last Name of the individual.</td>
</tr>
<tr>
<td>----------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>First Name</td>
<td>Enter the First Name of the individual.</td>
</tr>
<tr>
<td>Driver</td>
<td>Check the box to indicate if this individual is a driver.</td>
</tr>
<tr>
<td>Technician</td>
<td>Check the box to indicate if this individual is a technician.</td>
</tr>
<tr>
<td>Office Phone</td>
<td>Enter the office phone number for this individual.</td>
</tr>
<tr>
<td>Mobile</td>
<td>Enter the mobile phone number for this individual.</td>
</tr>
<tr>
<td>Address</td>
<td>Enter the address for this individual.</td>
</tr>
<tr>
<td>City</td>
<td>Enter the City for this individual.</td>
</tr>
<tr>
<td>State/Province</td>
<td>Enter the State or Province for this individual.</td>
</tr>
<tr>
<td>Postal Code</td>
<td>Enter the Postal Code for this individual.</td>
</tr>
<tr>
<td>Emergency Contact Information</td>
<td>Enter the Emergency Contact Information for this individual.</td>
</tr>
<tr>
<td>Driver's License #</td>
<td>Enter the driver's license number.</td>
</tr>
<tr>
<td>Expires</td>
<td>Enter the date when the driver's license expires.</td>
</tr>
<tr>
<td>Certifications (Driver)</td>
<td>Enter any Driver Certifications that this individual holds.</td>
</tr>
<tr>
<td>Notes/Incidents (Driver)</td>
<td>Enter any driving related Notes/Incidents regarding this individual.</td>
</tr>
<tr>
<td>Certifications (Technician)</td>
<td>Enter any Technician Certifications that this individual holds.</td>
</tr>
<tr>
<td>Notes (Technician)</td>
<td>Enter any technician related Notes for this individual.</td>
</tr>
<tr>
<td>File Attachments</td>
<td>Add any file attachments for this individual.</td>
</tr>
</tbody>
</table>

### 3.6 Vendors

Vendor records contain the details for the Vendors with whom you do business. This screen provides you with a quick reference list of Vendors and their main phone number and website, as well as email addresses and phone numbers of specific Contacts at each Vendor. This information is also available in a printable format on the Reports screen.

Sort the list by clicking on the column header.
Vendors Screen (All Vendors tab selected)
3.7 Options

The Options screen allows you to set the Units of measure for Vehicle Manager.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Currency</td>
<td>Select the currency symbol to be displayed in the data entry area and the reports. Or select Windows Default to use the currency symbol defined in the Windows Regional and Language settings. For information about how to change the Windows Default currency, see the following link on the</td>
</tr>
</tbody>
</table>
Microsoft Support site:
Windows Currency Settings

<table>
<thead>
<tr>
<th>Volume</th>
<th>Select the unit of measure for Volume (for fuel entries).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Efficiency</td>
<td>Select the fuel efficiency units you would like to use.</td>
</tr>
<tr>
<td>Odometer</td>
<td>The Odometer units may be set on a &quot;per vehicle&quot; basis. Set the Odometer units on the General tab.</td>
</tr>
</tbody>
</table>

3.8 Reports

Vehicle Manager comes with several built-in reports to provide Vehicle information for your organization. The reports can be exported to a variety of formats. Or, to export the raw data, see the Export section.

See Also
3.8.1 Report Details

**Vehicles and Service**

**Vehicle List**  
The Vehicle List report displays a list of all vehicles in the database.

**Vehicle by Type**  
The Vehicle List report displays a list of all vehicles grouped by Type.

**Vehicle by Department**  
The Vehicle List report displays a list of all vehicles grouped by Department.

**Service**

**Service and Expense Summary**  
The Service and Expense Summary report displays a list of all service and expenses for each vehicle. When you click on the link to open the report, a date filter dialog box will open to allow you to filter the report by date.

**Service and Expense Detail**  
The Service and Expense History report displays a list of all service and expenses for each vehicle with a line item break down for the expenses. When you click on the link to open the report, a date filter dialog box will open to allow you to filter the report by date.

**Service Reminders**  
The Service Reminders report displays a complete list of upcoming service reminders for all vehicles.

**Service Schedules**  
The Service Schedules report displays a complete list of service that has been scheduled for all vehicles. This report includes the "Last Completed" date and odometer reading as well as the "Next Due" date and odometer reading.

**Parts and Vendors**

**Parts List**  
The Parts List report displays all parts in the master parts list.

**Vendor Addresses**  
The Vendor Addresses report displays a list of the vendor addresses from the Vendors section.

**Vendor Contacts**  
The Vendor Contacts report displays a list of Contacts at each of your vendors. This report may be printed out for quick reference.

**Fuel Log**

**Fuel Log Detail Report**  
The Fuel Log Details report contains a list of all fill-ups within the selected date range. The fuel efficiency is displayed for each fill-up as well as an average for the range of the report.
Fuel Log Summary By Vehicle
The Fuel Log Summary report displays the sum of all Fill-ups, Distance, Volume of fuel, Cost, and Average Fuel Efficiency for each vehicle for the selected date range.

Fuel Log Summary By State/Province
The Fuel Log Summary By State/Province groups the fuel log summary by the state or province where the fill-up took place.

Miscellaneous

License and Insurance
The License and Insurance report displays the insurance details including the license renewal and insurance due date for each vehicle.

Vehicle Usage Summary
The Vehicle Usage Summary report displays a break-down of Business Miles/Kilometers versus Personal Miles/Kilometers for each vehicle.

Personnel List
The Personnel List report displays a complete list of Personnel in the database.

4 System Administration

Select a System Administration topic below:

- Firebird Database Server
- Troubleshoot Connections
- Schedule Daily Database Backup
- Update The Client Software
- Upgrade To Multi-User
- Technical Details
- Move To A New Computer
- Move Database To New Server

Advanced Configuration:

- Command Line Options
- Citrix/Terminal Server Configuration
- File Locations
- Change the port number
- Multiple Databases Per Server
- Multiple Firebird Instances
- Configure Email Client
- ODBC Connections

Note: the remote database features described in this section are for the "Fleet Network Edition" only. The other editions (Home, Professional, Fleet) do not have the remote database feature available.

4.1 Firebird Database Server

Note: the remote database features described in this section are for the "Fleet Network Edition" only. The other editions (Home, Professional, Fleet) do not have the remote database feature available.
Network Setup Overview

When you install the Vehicle Manager client software on your computer, an embedded database is installed by default to allow you to try out the software without further configuration. However, when you're ready to share the software on a network with multiple users, you need to install a shared database on a server. Any Windows computer may act as the database server, as long as it is accessible from all of the computers which need to access the shared database. You also want to make sure the computer is able to run without interruption to avoid any potential for database corruption which might occur if the computer is restarted while users are connecting to and using the database.

There are three basic configurations to choose from. Click on a diagram below to view full size:

Configuration Instructions

Each of the configurations require three basic steps:

1. Install the client software on the computers which will run Vehicle Manager.
2. Install the database server software on a shared Windows server.
3. Connect the client computers to the database server.

You may watch a 3 minute instructional video, or follow the steps below:

Step 1: Install the client software

The client software is the program that users interact with to enter and update Vehicle records. If you have used the trial version of Vehicle Manager, then you have already installed at least one copy of this software. This software is available for download at:

http://www.kzsoftware.com/products/vehicle_maintenance/demo.htm

Note that in order to connect to a shared database server, you must install the "Vehicle Manager Fleet Network Edition". All editions of Vehicle Manager start in single user stand-alone mode by default. The "Vehicle Manager Fleet Network Edition" can also connect to a remote central database server.

Step 2: Install the database server software

The database server software is very easy to install in the default configuration. To install in the default configuration, follow these steps:
1. Log on to your server and download the setup program from:
2. Note that this is a different setup program than the one installed on the client computers.
3. Run the setup program, and accept all defaults.
4. This program will install a Firebird Database Server and a Vehicle Manager database.

If you are using the Windows Firewall, configure it to allow Inbound TCP connections on Port 3050 as described below:

**For Windows Server 2008, and later (2012, 2016, 2019):**
1. Open the Windows Firewall With Advanced Security: Start --> Search --> enter "firewall", and select the program "Windows Firewall With Advanced Security".
2. Select "Inbound Rules" in the left pane.
3. Click "New Rule" in the Actions pane on the right, and create a rule with the following settings:
   - Rule Type: Port
   - Protocol: TCP
   - Specific Port: 3050
   - Action: Allow the connection.
   - Profile: As required.
   - Name: Firebird

**For Windows Server 2003 and 2000:**
1. Open the Windows Firewall dialog: Start --> Run --> enter "firewall.cpl", and then click the Ok button.
2. Go to the Exceptions tab, and then click the Add Port button.
3. Enter a name such as "Firebird Database", and then enter the port number 3050, and click Ok.

**Step 3: Connect the client computers to the shared database**

After installing the database server, connect your client computer(s) to the shared database server by following these steps:

1. Open Vehicle Manager on one of the client computers which it is installed on.
2. Select the menu option Tools --> Database Connection (Note: if you don't see this option, you need to install the "Vehicle Manager Fleet Network Edition" from: http://www.kzsoftware.com/products/vehicle_maintenance/demo.htm)
3. Enter the name of the database server in the connection dialog box (if you don't know the name of the server, log on to the server and right-click "My Computer", choose "Properties", and then select the "Computer Name" tab.) Note that you only need to enter the name of the database server - you do not need to enter a file path when connecting to a remote database server. The file path is only required when connecting to a local database file.
4. Click Ok
5. Close and then reopen Vehicle Manager. You’re now connected to the shared database server.

Note: If you cannot connect to the database server, please see the following section: Troubleshooting Connections.

When you’re finished configuring the database connection, set up a scheduled task to backup the database daily.

**Advanced - Database File Storage:**

If you are a server administrator and would like to change the default location where the Vehicle
Manager database is stored, you may do so by following the instructions below. Vehicle Manager is designed to run with the standard options "out of the box", and in most cases there is no reason to change the defaults; however, these instructions are provided for server administrators who would like to change the default installation.

1. First stop the Firebird database service.
2. Next copy the database file from C:\KZSoftware\VehicleData.vdb to the new location where you would like it to be stored. Note: the new location must be located on a hard drive that is physically connected to the host machine. It cannot be located on a mapped drive, a file system share, or a network file system.
3. Next, open the file C:\Program Files\firebird\aliases.config in notepad and change this line: VehicleManager=C:\KZSoftware\VehicleData.vdb to reflect the new path to the database file.
4. Finally, restart the Firebird database service.

4.1.1 Client Server Configuration

**Configuration: Standard Client Server**

---

**Role: Database Server**
- Software: KZFirebird Database*
- Other: Port 3050 open for TCP

*KZFirebird package includes Firebird 2.1.3, database files, and default configuration.

**Role: Client PCs**
- OS: Windows XP, Vista, 7
- Software: Client software - Enterprise/Network Edition**

Locally installed client software connects to the Firebird database over TCP port 3050. Use client menu option Tools → Database Connection to connect.

---

See Also

- Network Setup Overview
- Single Office: Shared Database on PC Configuration
- Multiple Offices: Terminal Server Configuration

© 2019 Kaizen Software Solutions
4.1.2 Shared Database on PC

Configuration: Shared Database on PC (No Server)

Scenario:
Small office environment with a database installed on one of the PCs and shared with multiple users.

On the PC which contains both the Firebird database software and the client software, use the menu option Tools --> Database Connection to set the database connection for multiple users and connect to "localhost". For all other PCs, set the database connection for multiple users and connect to the database by machine name or IP Address.

See Also

- Network Setup Overview
- Single Office: Client Server Configuration
- Multiple Offices: Terminal Server Configuration
4.1.3 Terminal Server Configuration

Configuration: Terminal Server

If you have installed both the Firebird database software and the client software on the same server, use the menu option Tools --> Database Connection to set the database connection for multiple users and connect to "localhost".

See Also
- Network Setup Overview
- Single Office: Shared Database on PC Configuration
- Single Office: Client Server Configuration

4.2 Troubleshoot Connections

Note: the remote database features described in this section are for the Fleet Network Edition only. The Single User Editions not have the remote database feature available.

If you have completed the steps for installing the Firebird database and are experiencing problems connecting to the database, check the error message description and then locate it in the table below for troubleshooting steps:

<table>
<thead>
<tr>
<th>Connection Error</th>
<th>Potential Causes</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unable to complete network</td>
<td>1. The server name or IP Address</td>
<td>Step 1: Click the &quot;Ping&quot; button.</td>
</tr>
<tr>
<td>Request to host [hostname].</td>
<td>Could not be found.</td>
<td>If the result is: &quot;Ping Failed&quot;, then the problem is Cause #1 to the left. Verify the server name or IP Address with your server administrator, and confirm that it is accessible on the network.</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>2. The Firebird service is not running on the server.</td>
<td></td>
<td>Step 2: Click the &quot;TCP/IP Test&quot; button. If the result is: &quot;No connection could be made because the target machine actively refused it&quot;, then the problem is Cause #2 to the left. If the result is: &quot;A connection attempt failed because the connected party did not properly respond after a period of time, or established connection failed because connected host has failed to respond [hostname:port], then the problem is Cause #3, or 4 to the left. Use the troubleshooting steps listed below this table for the specified cause to resolve the problem.</td>
</tr>
<tr>
<td>3. A firewall is blocking access to the port.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. The port entered on the Advanced tab does not match the port that Firebird is listening on.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| No connection could be made because the target machine actively refused it. | The Firebird service is not running on the server. | Start the Firebird service in Windows Control Panel --› Administrative Tools --› Services. If the Firebird service is not listed there, install the KZFirebirdServer package as described in the shared database configuration instructions. If you have run the KZFirebirdServer installer, but the service is not displayed or will not run, an anti-virus software may have interfered with the installation. Temporarily disable any anti-virus software and install KZFirebirdServer again. |

| I/O Error for file "Vehicle Manager" Error while trying to open file | 1. The database file is in use by another application and is locked. | 1. If another application has the database opened in single user mode, close the application or connect in multi-user mode to |
2. The database port is in use by another instance of Firebird or other service.
3. The Database Alias name entered on the Advanced tab was not found on the Firebird server.
4. The database file is not in the location on the server specified in aliases.conf.

Your user name and password are not defined. Ask your database administrator to set up a Firebird login.

The value entered in the SYSDBA password field does not match the SYSDBA password on the Firebird server.

Note: The SYSDBA password is used by the database server. It is not the same as the application passwords that have been set up for personnel to login to the client software.

Leave the setting as the default value unless it has been changed on the server.

If the Firebird administrator has changed the SYSDBA password for the Firebird database, request the password or have the administrator enter the password for you in the SYSDBA Password field.

If the SYSDBA password has not been changed, there may be another instance of Firebird running on the server with a different SYSDBA password. See the multi-instance configuration instructions in the user guide.

Unsuccessful execution caused by a system error that precludes successful execution of subsequent statements. I/O error for file "SharedDocs\security2.fdb". Error while trying to open file. The system cannot find the path specified.

This message may appear when attempting to use the database from a file share. A database being accessed through a file share is subject to data corruption. Firebird is designed to run in client-server configuration for multiple users.

Install and connect to Firebird as described in the Shared Database Configuration instructions.

Any other error message not listed above.

Unknown

Check each of the items listed below and then try again. If the
Check the Windows firewall

The Windows firewall is a frequent cause for not being able to connect to the server. Make sure port 3050 is available for Inbound TCP connections on the server. Here are the steps:

**For Windows 2003 and earlier:**
1. Open the Windows Firewall dialog: Start --> Run --> enter "firewall.cpl", and then click the Ok button.
2. Go to the Exceptions tab, and then click the Add Port button.
3. Enter a name such as "Firebird Database", and then enter the port number 3050, and click Ok.

**For Windows 2008 and later:**
1. Open the Windows Firewall With Advanced Security: Start --> Search --> enter "firewall", and select the program "Windows Firewall With Advanced Security".
2. Select "Inbound Rules" in the left pane.
3. Click "New Rule" in the Actions pane on the right, and create a rule with the following settings:
   - Rule Type: Port
   - Protocol: TCP
   - Specific Port: 3050
   - Action: Allow the connection.
   - Profile: As required.
   - Name: Firebird

Check the Firebird database process

If you have already configured the firewall and are still unable to connect, please check to see if the Firebird database process is running on your server.

1. Open the Windows Task Manager: Start --> Run --> enter "taskmgr", and then click the Ok button.
2. Go to the processes tab, and make sure the checkbox for show processes for all users is checked.
3. Sort the processes by clicking on the Image Name column header and look for a process named fb_inet_server.exe (if running the default Firebird Classic), or fbserver.exe (if running Firebird Super Server).
4. If the process is not there, please install the Firebird Server.

Confirm the database connection setting

If you have configured the Firewall and the database process is running, confirm that the database connection setting on the client is correct.

- Log in to the Enterprise client, and go to Tools --> Database Connection.
- Confirm that the bottom radio button is selected for a multi-user database. If the top radio button is selected, only a single user will be able to access the database - the database will be locked and an I/O error will occur for subsequent connection attempts.
- Confirm that the name of the database server is entered correctly. It should be the name only, no slashes, file paths, etc. To find the name of your database server, log on to the server and then right-click "My Computer", choose "Properties", and then select the "Computer Name" tab. If the DNS is not resolving the computer name correctly, you may need to use the IP Address instead.

If the problem continues, there may be an anti-virus or other security software blocking the process on
the server.

**Check firebird.log for errors**

Log in to the server, and check the firebird.log file in the Program Files \ Firebird directory for errors.

You may see an error such as the following: "INET/inet_error: select in packet_receive errno = 10038"
--> This error indicates that the Firebird server process cannot operate correctly due to network interference which may be caused by an anti-virus or other security software blocking it. Check your security software and exclude the Firebird process or temporarily disable the security to test the connection again.

inet server err: setting KEEPALIVE socket option or inet server err: setting NODELAY socket option
--> This error may indicate that you need to use the "SuperServer" version of Firebird instead of the "Classic" version. You can download the SuperServer version [here](#).

### 4.3 Schedule Database Backup

Note: the remote database features described in this section are for the Enterprise Edition only. The Standard Edition does not have the remote database feature available.

You can set an automated schedule for backing up a server based database every day using the Windows Scheduled Tasks utility. For convenience, batch files are included in the Firebird bin directory to create the scheduled tasks and to backup the database.

**Automatic Configuration of the Scheduled Tasks**

Use these steps to create a Windows scheduled task on your server to automatically backup your database.

1. Locate the batch file on your server at: *C:\Program Files\Firebird\KZFirebird\bin\ScheduleVMBackup.bat*
2. Double-click the batch file to run it. If you get an Access Denied message, right-click on the file and choose "Run as Administrator".

*The Firebird directory may be in the "Program Files" or "Program Files (x86)" directory.
If the batch file does not exist on your server, perform the manual configuration described in the next section.

**Important: Run the scheduled task to test it as described below the next section and confirm that the database backup file is created as expected.**

**Manual Configuration of the Scheduled Tasks**

Follow these steps to configure the scheduled task manually only if your installation does not contain the "ScheduleVMBackup.bat" file, or the automatic configuration was not successful. If your scheduled task has already been created, skip to the next section to test it.

1. Download the backup batch file - right-click on the link below and select "Save Target As" or "Save Link As".
   **Batch File:** [Backup Vehicle Manager](#)
2. Save the file to the Firebird bin directory at: *C:\Program Files\Firebird\KZFirebird\bin*
   The batch file must be located in the bin directory which contains the gbak utility.
Windows 2008/2012/2016:

In Windows, go to Start --> All Programs --> Accessories --> System Tools --> Task Scheduler or - Start --> Run --> control.exe schedtasks
Click the "Create Task" link in the Actions pane on the right side of the window, and then set the following:

General Tab:
Enter a Name: Backup Vehicle Manager
Enter a description: Backup the Vehicle Manager database
Select "Run whether user is logged on or not"

Triggers Tab:
Add a new trigger to run the task Daily.

Action Tab:
Add a new Action to "Start a program".
Select the BackupVehicleManager.bat file which you have previously saved in the KZFirebird\bin directory.

Windows 2000/2003:

1. In Windows, go to Start --> All Programs --> Accessories --> System Tools --> Scheduled Tasks or - Start --> Run --> control.exe schedtasks
2. Click "Add a scheduled task"
3. Click "Next"
4. Click "Browse..." and then select the batch file you downloaded in Step 1.
5. Select the radio button to perform this task "Daily"
6. Click "Next"
7. Select a start time and then click the "Next" button.
8. Enter the user name and password for the Windows account which will be used to execute the task, and then click the "Next" button.
9. Click the "Finish" button.

Important: Run the scheduled task to test it as described below and confirm that the database backup file is created as expected.

Run the scheduled task and confirm the operation.

- In Windows, go to Start --> All Programs --> Accessories --> System Tools --> Task Scheduler or - Start --> Run --> control.exe schedtasks
- Right-click on the scheduled task you created and select "Run".
- A console window will open and execute the command automatically before closing.
- After the window closes, confirm that a backup file has been created in the folder at C:\Backup.
- The backup file will be compressed, and may be much smaller than the uncompressed database file.
- If the backup file is not created, open the batch file in Notepad, and confirm/update the file path to the gbak utility if needed.
- When finished, log off the computer and allow the backup task to run at it's scheduled time, and then confirm that a new file has been created when the task ran as scheduled.
- After you have confirmed that the backup file is being created as expected, be sure to update your organization's disaster recovery preparedness procedures to include the system information.
good plan will include a schedule to periodically audit the process and test a database recovery on a separate test system.

**More information about the batch file**

- By default, the batch file will keep the 10 most recent backups of your database.
- On the 11th day, the oldest backup file will be replaced with the current backup file.
- Backup files are named using the database name plus a number at the end. The most recent backup file ends with the number 1. The oldest backup file ends with the number 10.
- The default backup location is at C:\Backup.
- The default number of copies to keep and the default backup location may be changed by editing the batch file in Notepad.
- Right click on the batch file and select "Edit" to make changes.
- Change only the values listed in the SET statements at the top of the batch file.
- Make only one change at a time, and test between each change to aid troubleshooting if necessary.

### 4.4 Update The Client Software

**Client Software Updates**

As new releases become available, you may upgrade the Vehicle Manager software as follows:

1. Make sure no one else is using the database (all other users should have Vehicle Manager completely closed).
2. Make a backup of the database for safety (File --> Backup).
3. Use the menu option Help --> Check for updates, and follow the installation prompts, or if you are unable to connect to our update server, close Vehicle Manager, and then install the current version of the software from our website. This will not overwrite your existing database.
4. After the update completes, open the software. If any database schema updates are required, a message will appear as shown below in the "Database Schema Updates" section. Wait until all updates have completed before any other users open the software.
5. Make sure all other users update their software to the same version to avoid any mismatched version conflicts.

You can find out more information about the changes in each update in the [Product Updates](#) section on our website.

Note: If your license is over 2 years old and you do not have a current support subscription, a 50% update charge may apply.

**Database Schema Updates**

Some updates to the software will also require an update to the database schema. When Vehicle Manager is opened, it checks the database to see whether a schema update is required. If the database schema requires an update, the following message will appear:
When you are sure no one else has the software open, click **Yes**, and then wait while the database schema is automatically updated. It is important to allow the update to proceed without interruption to ensure the integrity of the update. The database could become corrupted if the update is interrupted by turning off the computer, or if another user attempts to login to the database while the schema update is taking place.

### Mismatched Versions

After a database schema update has taken place, all computers with the software installed should be updated to the same version. When a version of the software which was designed for an older database schema is used to connect to a newer database schema, the following message will appear when the software is opened:

![Warning: Mismatched database version](image)

In addition, an error message will appear when performing any function which requires the new database schema. To prevent the error messages, coordinate all updates so that all users are running the same version of the software.

### 4.5 Upgrade To Multi-User

If you start out with a standalone database on a single computer and then decide to change to a shared database for multiple computers, you can copy your existing data to the server so that you don't lose your previous work. The basic process is to create a backup file of your local database before the switch over, and then restore it to your new server database.

**Steps to upgrade to multi-user**

1. Backup your local database (menu option: File --> Backup). This will create a compressed backup file containing your data.
2. Install and configure the remote database server (to be performed by server administrator). See instructions here: [Shared Database Configuration](#)
3. Install the Fleet Network edition of the client software on your computer if it is not currently installed. A link to install the client software is included in the instructions at the link above.
4. Connect to the remote database server (menu option: Tools --> Database Connection).
5. Restore your local database backup copy to the server (menu option: File --> Restore). Select the backup file that you created in Step 1, and then click the Restore button.
6. You can then install the Fleet Network edition on additional user’s computers and connect them to the remote database server (step 4).

Note: if you are currently licensed for a standalone version of the software only, you will need to purchase an upgrade license key to continue adding new data to the server database. Refer to the link in your original license notification email, or contact us through the Support page on our website at www.kzsoftware.com. Let us know what your current license number is, and we will provide you with a link to purchase an upgrade license.

4.6 Technical Details

System Requirements

The initial installation of the Firebird Server for your database will require 20 mb. The normal rate of growth of the database file without file attachments is 1 MB per 7000 records. Pictures in the personnel records can be added at a rate of about 6 MB per 100 personnel. If file attachments are added to records, the database will grow in size based on the size of the attachments.

Client:
- Required Disk Space: 90 mb
- Minimum CPU: 1 Ghz
- Operating System: Windows 7 or higher (7, 8, and 10) - 32 or 64 bit.
- Notes: The setup process will download and install the .NET Framework v 4.5.2 if it is not already installed.

Database Server:
- Required Disk Space: 27 mb for the Firebird server component.
- Minimum CPU: 1 Ghz
- Ports: The server must accept TCP connections on port 3050.
- Notes: KZFirebirdServer.exe will install the Firebird server v. 2.1.7 and the default database files. No additional components such as .NET or Java are required on the server.

Vehicle Manager Database

- Vehicle Manager stores all of the data and pictures in a single database file.
- Vehicle Manager Database files have the file extension ".vdb".
- Vehicle Manager backup files are compressed to save space and have the file extension ".vbk".
- Vehicle Manager uses the open source Firebird database version 2.1.7 for data storage.
- The local database is stored at the following location:
  - Windows XP (for older versions of the software): C:\Documents and Settings\All Users\Application Data\VehicleManager\VehicleData.vdb
  - Windows 7, 8, and 10:  C:\Program Data\VehicleData.vdb
- The remote database is stored at the following location on the database server: C:\KZSoftware\VehicleData.vdb
- Third-party applications can read the Vehicle Manager database via ODBC. See additional information at the following link:
**Firebird ODBC Connection.**

**Firebird Facts**

**Firebird in the Enterprise**

**Get to know Firebird**
http://www.firebirdnews.org/docs/fb2min.html

### 4.7 Move To A New Computer

If you get a new computer or need to move the Standard (single user) Edition of Vehicle Manager to another computer, you may do so as follows:

**On the Original computer:**

1. Go to the menu option Help --> Enter License Key, or Help --> About, and write down your license key and version number to use later.
2. Go to the menu option File --> Backup, and create a backup file.
3. Copy the backup file created in step 2 from the old computer to the new computer.

**On the New computer:**

4. Download and install the same edition and version of the software from the Software Archive, and then go to the menu item Help --> Enter License Key, and enter the license key number from Step 1.
5. Select the menu option File --> Restore, and then select the backup file that you copied over from the old computer.
6. Close and then reopen Vehicle Manager.

### 4.8 Move Database To New Server

If you need to decommission an older server or move your database for another reason, you may move an existing database from one server to another by backing up the old database and restoring it to the new database as described below. Be sure to follow the steps carefully and check which database you are connected to when performing the restore operation in order to avoid overwriting your old database.

1. While connected to your ORIGINAL server, create a backup of the database using the Vehicle Manager menu option File --> Backup. This will create a compressed backup file with the name and location that you choose.
2. Install the Firebird Database component on your NEW server. See Step 2 in the Firebird Database Server configuration instructions for details.
3. Connect Vehicle Manager to the NEW server as described in Step 3 of the Firebird Database Server configuration instructions. Close and reopen Vehicle Manager, and make sure you are connected to the NEW database.
4. Now restore the data to the NEW server from the backup file that you created in Step 1. Use the restore feature available in Vehicle Manager from the menu item File --> Restore. Select the backup file that you created in Step 1, and then click the Restore button to overwrite the NEW database with the data from your backup file.
5. After you have completed restoring the data from your ORIGINAL server to your NEW server, make sure all computers which are using Vehicle Manager have been updated to connect to the NEW server.
(Tools --> Database Connection), and then shut down or remove the Firebird services from the original server to make sure no one mistakenly uses it.

4.9 Advanced Configuration

Select a topic below:

- Command Line Options
- Citrix/Terminal Server Configuration
- File Locations
- Change the port number
- Multiple Databases Per Server
- Multiple Firebird Instances
- Configure Email Client
- ODBC Connections

4.9.1 Command Line Options

**Command line options for the Network Edition:**

`/server [Server Name Or IP Address]`
Specify the server name or ip address of the server where the Vehicle Manager database is running.
Default: previously used server name.

`/alias [Name of database alias]`
Specify the name of the database alias to connect to.
Default: previously used alias name.

`/userprofile [roaming]`
Specify "roaming" to use a Roaming profile for User.config settings.
Default: Local User.config settings.

You may create a shortcut on the desktop, and then edit the shortcut properties to modify the target to include the parameters at the end.

Example Usage:
"C:\Program Files\Vehicle Manager 2016 Enterprise\VM.exe" /server localhost /alias VehicleManager /userprofile roaming

**Installation (setup file) command line parameters:**

Options for the setup file can be set for unattended installations. For a complete list of setup command line parameters, please see the following link:

[Setup command line parameters]

4.9.2 Citrix/Terminal Server Configuration

If you have installed the client software on a Citrix/Terminal Server, you will need to manually configure the default database connection settings for new users. New user profiles will then use the database
connection setting that you define rather than the default local file-based database connection. A server-based connection is required in order to have more than one user logged into the client at the same time. There are two options available for setting a default database server to connect to:

**Option 1: Set command line options in the user's shortcut.**

For details, please see the Command Line Options section in this User Guide.

**Option 2: Update the VM.exe.config file to specify the default value for new windows profiles.**

On the Terminal Server:

1) First, make a backup copy of the VM.exe.config file which is located in the C:\Program Files\[Program Name] directory.

2) Next, open the [Program Name].exe.config file in Notepad, and make the changes as shown below. Copy the "New Values" section and then paste it over the similar sections in your config file to make sure it is exact. If the Firebird database is on a different server, replace "localhost" with the name of the server which hosts the Firebird database.

**OLD VALUES:**

```xml
<setting name="DBType" serializeAs="String">
  <value>FirebirdEmbedded</value>
</setting>

<setting name="RemoteDatabase" serializeAs="String">
  <value /></value>
</setting>
```

**NEW VALUES:**

```xml
<setting name="DBType" serializeAs="String">
  <value>FirebirdServer</value>
</setting>

<setting name="RemoteDatabase" serializeAs="String">
  <value>localhost</value>
</setting>
```

3) Save the changes and open the client to confirm the settings are correct.

Note: If you have already logged in with some other user accounts, make sure those profiles have the matching database settings set using the menu option Tools --> Database Connection (while logged in with the existing user account). The configuration above will set the default for all NEW profiles created (profiles are created the first time a user opens the application while logged on to the machine with their windows account).

You may also test your updates as follows:
After making the changes to the program config file as shown above,
Delete the user.config file in the local user application data directory (see File Locations).
Open the application. It will load the application configuration and re-create the user.config file.

If the application displays an error message after making the changes, restore the backup of the program config file. If you do not have a backup of the program config file, delete it and then reinstall the application to restore the default version.

**Troubleshooting Errors in Citrix**

In some cases, when opening the software running on Citrix, an exception will occur with the message `system.nullreferenceexception`, and the screen may be blank or contain a large red 'X'. This can happen due to Windows not having a primary screen defined.

Conditions for not having a primary screen defined on Citrix server:

- Having a Citrix client using dual screen with primary screen set on the right,
- Having a cumulated resolution X colorDepth of client dual screen higher than the maximum video memory allowed on Citrix server per client.

Solutions for this problem include:

- In the display properties, change the primary screen to the one on the left.
- In the display properties, change the resolution to a lower value.

Note: You may need to close the Citrix session and login again after changing these values for the change to take place properly.

4.9.3 **File Locations**

Below is a listing of default file locations for Config, Database, and Log files for our software products. This information may be useful for special configurations or when diagnosing a connection error. In most cases you will not need to modify these files. If you decide to modify any of the files listed below, create a backup copy of the original file before changing it.

**Config Files**

<table>
<thead>
<tr>
<th>File Name</th>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Program Name].exe.config</td>
<td>Program Files[Program Name]</td>
<td>This file contains the default values that will be used to create the initial user.config file which in turn is used to store individual user preferences.</td>
</tr>
<tr>
<td>user.config</td>
<td>Local Users Application Data folder*</td>
<td>This file is created the first time a specific user opens the program, and it is updated as preferences are changed.</td>
</tr>
<tr>
<td>aliases.conf</td>
<td>Program Files\Firebird (on the server)</td>
<td>This file is used by the Firebird server process to lookup the physical location of the database file.</td>
</tr>
</tbody>
</table>

**Database Files**
<table>
<thead>
<tr>
<th>File Name</th>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Program Name].vdb</td>
<td>All Users Application Data folder*</td>
<td>This is the raw Firebird database file used by the embedded client.</td>
</tr>
<tr>
<td></td>
<td>(on the client)</td>
<td></td>
</tr>
<tr>
<td>[Program Name].vdb</td>
<td>C:\KZSoftware[Program Name].vdb</td>
<td>This is the raw Firebird database file used by the Firebird server process.</td>
</tr>
<tr>
<td></td>
<td>(on the server)</td>
<td></td>
</tr>
</tbody>
</table>

**Log Files**

<table>
<thead>
<tr>
<th>File Name</th>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>log.txt</td>
<td>All Users Application Data folder*</td>
<td>This file contains the log of any application errors that occur on the client.</td>
</tr>
<tr>
<td></td>
<td>(on the client)</td>
<td></td>
</tr>
<tr>
<td>firebird.log</td>
<td>C:\Program Files\Firebird\firebird.log</td>
<td>This file contains the log of any firebird database errors that occur on the server.</td>
</tr>
<tr>
<td></td>
<td>(on the server)</td>
<td></td>
</tr>
</tbody>
</table>

**System Defined Folders**

*Local Users Application Data Folder:*
The location of this folder varies according to the operating system:
- Windows XP: C:\Documents and Settings\[user account name]\Local Settings\Application Data\Kaizen_Software_Solutions\[Unique Program ID]
- Windows Vista, 7, 8, and 10: C:\Users\[user account name]\AppData\Local\Kaizen_Software_Solutions\[Unique Program ID]

You may also find this folder by typing %USERPROFILE% in the "Run" box (Windows XP), or the "Search" box (Windows Vista, 7, and 8) and then drilling down into the appropriate folder.

*All Users Application Data Folder:*
The location of this folder varies according to the operating system:
- Windows XP: C:\Documents and Settings\All Users\Application Data\[Program Name]\[database file]
- Windows Vista, 7, 8, and 10: C:\Program Data\[Program Name]\[database file]

You may also find this folder by typing %AllUsersProfile% in the "Run" box (Windows XP), or the "Search" box (Windows Vista, 7, 8, and 10) and then drilling down into the appropriate folder.

These folder locations are hidden by default, so you may need to show all files and folders in order to find them (My Computer --> Tools --> Folder Options --> View tab --> Show all files and folders).

### 4.9.4 Change the port number

The default Firebird configuration listens for incoming connections on port 3050. If you are running only once instance of Firebird, then no changes are required. However, if you have multiple instances of Firebird running on one machine, then each one must listen on a different port. You can change the port that a given instance uses by modifying the firebird.conf file which is located in the Firebird directory for that instance.

**Important Note:** The information in this section is provided for advanced configuration only. In most cases, only one instance is required so the default port setting can be used and
none of the changes listed in this section are needed.

**Set the port which Firebird uses**

To change the port from 3050 to 3051, open the file C:\Program Files\Firebird\KZFirebird\Firebird.conf in Notepad, and locate the line containing "RemoteServicePort". Then modify the setting as follows:

OLD: #RemoteServicePort = 3050
NEW: RemoteServicePort = 3051

**(Remove the # sign and change the port number to 3051)**

After changing the port and saving the changes. Stop the Firebird service and then Start it again.

**Connect using the new port**

After changing the port number that the database listens on, you will need to update the port number that the client software connects to as follows:

1. Select the menu option Tools --> Database Connection.
2. Select the "Advanced" tab.
3. Uncheck the "Default" checkbox and set the Port to the new value.

4.9.5 **Multiple Databases Per Server**

[Fleet Network Edition]: A database server can be configured to host multiple completely separate databases which can be identified with a unique name (Alias). You can choose which database to connect to by entering the name of the alias on the Advanced tab of the database connection form, or by setting up separate shortcuts for each database. See below for details:

Setting up the server:

1. First, install the Firebird database software and configure it for use with a single database as described in the shared database configuration instructions (if you haven't already).
2. After successfully installing, configuring, and testing the shared database, close all connections to the database and then make a copy of the database file located in the directory C:\KZSoftware. Name this file to distinguish it from the other files as needed. For example, if this is a test database, you may name it: VehicleDataTest.vdb.
3. Lastly, use notepad to open the file "aliases.conf" (located in the Program Files \ Firebird directory), and add a new line containing the path to the new database file you created in Step 2, and an "Alias" name you will use to refer to this connection. Use the same format as the existing entries in the file. You may copy an existing entry and then paste it in at the bottom of the file and make changes to the alias name and database file path as needed. Be sure each database file has a unique alias name. In keeping with the "Test" database example, you might name the new alias, "VehicleDataTest".

At this point, you should have already connected to the default alias from the client, and you can test the connection to the new alias as follows:

Connection to the new alias:

1. Open the client software, and select the menu item Tools --> Database Connection.
2. Select the "Advanced" tab, and change the "DB Name (Alias)" field to the name of the new Alias you
created in Step 3 of the server setup.
3. You can now test the connection and then save it.

You can also set up multiple shortcuts to open the client with the specified database alias selected. For more information, please see the Command Line Options in the user guide at the following link:

Command Line Options

4.9.6 Multiple Firebird Instances

The Firebird database server supports the option to run multiple instances on one machine. Each instance can be given a name and run as a Windows Service. This may be needed if you have other applications which require you to run a different version of Firebird on your server.

The KZFirebirdServer installer has been updated to install a named instance as follows:

Instance Name: "KZFirebirdInstance"
Directory: C:\Program Files\Firebird\KZFirebird

It will appear in the list of Windows Services with the name, "Firebird Server - KZFirebirdInstance".

If additional Firebird instances are installed, you will see the services listed with different names. A default Firebird installation which has not been given an instance name will appear with the name "Firebird Server - DefaultInstance".

To run multiple instances of Firebird, each instance must be configured to listen on a different port. For details, see the topic: Change the port number.
4.9.7 Configure Email Client

When sending a report by email, Vehicle Manager will attempt to open the email client which has been configured in Windows as the "Default" email client. You can designate which email client is the default one as follows:

**In Windows XP:**

1. Open Internet Explorer
2. Select Tools --> Internet Options from the menu.
3. Select the Programs tab.
4. Select your desired email client from the drop down list.
5. Click Ok.
6. To test your selection, click this link to see if it opens your desired email client.

**In Windows Vista, 7, and 8:**

1. Click Start.
2. Type “default programs” in the Start Search box.
3. Click Default Programs under Programs in the search results.
4. Click Set your default programs.
5. Highlight your desired email client on the left.
6. Click Set this program as default.
7. Click Ok.
8. To test your selection, click this link to see if it opens your desired email client.

**In Windows 10:**

1. Click on the Start menu button - lower left.
2. Click on the Settings menu item.
3. Click on the System icon.
4. Click on the Default Apps menu item.
5. Look for the Email heading, and click on the current default email client just below the heading.
6. Select your desired email client.
7. Close the Settings window.
8. To test your selection, click this link to see if it opens your desired email client.

**Notes:**
- The email addresses used for the reminders come from the "Email" field on the personnel form.
- You may need to restart Training Manager after making the changes to your default email client.

**Troubleshooting**

**Problem:**
I want to use Gmail for the email client, but it is not listed in the options for default email client.

**Solution:**
If Gmail is not listed as an option for a default email client in your version of Windows, you will need to install a 3rd party utility which can be set as the default and configured to send via email. Here is a link to a utility which provides that feature: Affixa
When sending an email to a list of email addresses, a message indicates that the email addresses should be separated by semi-colons instead of commas. Note however, that a comma is designated to be used to separate email addresses in RFC Section 3.4 for Internet Message Format.

**Solution:**
Microsoft has acknowledged a bug for this issue in Outlook 2003 and Outlook 2007. Per their support page: "Status: Microsoft has confirmed that this is a problem in the Microsoft products that are listed at the beginning of this article." Microsoft has also provided the following solution:

Follow these steps to configure Outlook to recognize the comma as a valid e-mail address separator:

1. On the Tools menu, click Options.
2. Click E-Mail Options, and then click Advanced E-Mail Options.
3. Under When sending a message, click to select the Allow comma as address separator check box.

Note You can still use a semi-colon (;) to separate e-mail addresses when you click to select the Allow comma as address separator check box.

See the following Microsoft support article for the full details: [http://support.microsoft.com/kb/820868](http://support.microsoft.com/kb/820868)

**Problem:**
When sending an email, the following message appears: "Either there is no default mail client or the current mail client cannot fulfill the messaging request".

**Solution:**
Set the default email client as described at the top of this page.

If the default email client has already been set, but the problem continues, the Outlook registry key may be corrupt. See the following article from Microsoft for solution details: [http://support.microsoft.com/kb/813745](http://support.microsoft.com/kb/813745)

If the above solutions do not resolve the problem, check to see if the version of Outlook installed is 64 bit. There is no benefit in using the 64 bit version of Outlook, and it is not compatible with many applications. See this article for more information: [http://www.msoutlook.info/question/461](http://www.msoutlook.info/question/461)

### 4.9.8 ODBC Connections

**ODBC Connection to Firebird Database**

You may connect to Firebird databases using an ODBC Connection. This allows you to connect 3rd party database utilities (such as MS Access or Crystal Reports) directly to the database.

**Important Notes:**

- **Perform read-only operations only, and make a backup of your database before attempting any direct database connections.**
- **Do not change the database schema or add new database views based on existing views. Future software updates may fail if a database view contains unexpected dependencies from a custom user-created database view.**
An ODBC driver is available at the following links:

- Firebird ODBC Driver (32 Bit Windows)
- Firebird ODBC Driver (64 Bit Windows)

Or check [this page](#) on the Firebird website for updated drivers and additional support.

After installing a Firebird ODBC Driver, follow the steps below to create an ODBC connection.

**Create an ODBC Connection in Windows**

**Step 1:** Add a new data source using the Firebird driver in the Windows ODBC Data Source Administrator.

![ODBC Data Source Administrator](image)

This control panel applet is available in Windows Administrative Tools.

**Step 2:** Select your data source and then click the Configure button to configure the settings:
Example Connection to a remote Training Manager database. For Asset Manager or Vehicle Manager, replace "Training" with "Asset" or "Vehicle".

Settings:

- **Database**:
  - For a local file database, select the database file (e.g. TrainingManager.tdb, VehicleData.vdb, or AssetManager.adb). In the file browser window, select "All Files" to remove the *.fdb filter from the file selection box.
  - For a remote database, enter the name of the server and the name of the database alias separated by a colon (no spaces).
- **Client**: Enter path to fbclient.dll. The fbclient.dll file can be found in the installation folder / odbc directory, or it can be downloaded here ([FBClient2.1.7](#)). Be sure to match the "bitness" (32 bit or 64 bit client).
- **Database Account**: SYSDBA
- **Password**: masterkey
- **Role**: [leave blank]
- **Extended Identifier properties**: quoted identifiers
- **Character Set**: UTF8
- **Dialect**: 3

**Firebird ODBC Connection Troubleshooting**

**Problem**: Cannot open database
Solution: Match 32 bit or 64 bit for all components:

1. ODBC Driver
2. ODBC Admin program
3. fbclient
4. Any 3rd party utilities such as MS Access, Crystal Reports, etc.

It gets confusing on 64 bit Windows 7 because there are two versions of the ODBC admin program. Oddly, the 32 bit version is stored in the SysWOW64 directory, while the 64 bit version is stored in the System32 directory:

- The 32-bit version of the Odbcad32.exe file is located in the %systemdrive%\Windows\SysWoW64 folder.
- The 64-bit version of the Odbcad32.exe file is located in the %systemdrive%\Windows\System32 folder.

Problem: “Tables not found” message in Crystal Reports.

Solution: Set the "Overidden Qualified Table Name" in the Properties for each table in the Crystal Reports set database dialog. Note that table names are case sensitive.

5 How To (Steps)

Select a topic below for step-by-step instructions:

- Adding a new vehicle
- Selecting an existing vehicle
- Deleting a vehicle
- Adding a new fuel entry
- Applying a service schedule template to a vehicle
- Adding a service schedule item to a vehicle
- Adding a service log entry
- Associating a part with a vehicle
- Managing the parts inventory
- Creating a new service schedule template
- Managing service items
- Managing vendor information
- Adding company information on reports

Adding a new vehicle
New vehicles may be added on the General tab of the Vehicle screen.

To add a new vehicle:

1. Click the "New" button.
2. Fill in the fields you want to track.
3. Click the "Save" button.

The vehicle you saved will be added to the list box on the left side of the screen.

**Selecting an existing vehicle**

There are two ways to select an existing vehicle:

1. Locate and click on the vehicle you're looking for in the Vehicle selection list.
   - The information for the selected vehicle will be loaded into the fields to the right of the selection box.

   -or-

2. Enter text in the search box and press enter or click the search button.
   - If only one vehicle matches your criteria, the information for the matching vehicle will be loaded into the fields to the right of the selection box.
   - If multiple vehicles match your criteria, a selection box will open for you to select from.

**Deleting a vehicle**

To delete a vehicle:

1. Select the vehicle in the Vehicle selection list and then press the delete key on your keyboard or press the delete button on the General tab.

   -or-

2. Right-click on the vehicle in the vehicle selection list and then select the menu item, "Delete Vehicle".

Click the Ok button when prompted if you are sure you want to delete the vehicle. Note: when a vehicle is deleted, all associated fuel log, service log, and service schedule entries will also be deleted.

**Adding a new fuel entry**

Fuel entries may be added on the Fuel Log tab of the Vehicle screen.

To add a new fuel entry:

1. Click the "New" button on the Fuel Log tab.
2. Fill in the fields you want to track.
3. Click the "Save" button.
The fuel entry you added will appear in the list box.

### Applying a service schedule template to a vehicle

To apply a service schedule template to a vehicle:

1. Open the "Service Schedules" tab on the Vehicles screen, and then click the "Apply Service Template" link in the upper right corner of the grid.
2. Select the service schedule template you would like to apply, and then click the Ok button.

The service schedule entries listed in the grid will be updated with the items from the template.

### Adding a service schedule item to a vehicle

To add an individual service schedule item to a vehicle:

1. Open the "Service Schedules" tab on the Vehicles screen, and then click the "New" button in the data entry section.
2. Select a service item from the list, or type in a new item.
3. Confirm or update the service frequency and next due fields, and then click the "Save" button in the data entry section.

The service schedule entry will be added to the schedule.

### Adding a service log entry

To add a service log entry:

1. Open the "Service Log" tab on the Vehicles screen, and then click the "New" button in the data entry section.
2. Select a service item from the list, or type in a new item.
3. Update the service date and odometer fields, and then click the "Save" button in the data entry section.

The service log entry will be added.

### Associating a part with a vehicle

To associate a part with a vehicle:

1. Open the "Parts/Materials" tab on the Vehicles screen, and then click the "New" button in the data entry section.
2. Select a part from the list, or type in a new part name.
3. Confirm or update the remaining fields, and then click the "Save" button in the data entry section.

The part will be associated with the vehicle and added to the list.

### Managing the parts inventory

The parts inventory list is accessed by clicking the "Parts" button in the main toolbar.
To add a new part:

1. Click the "New" button on the parts list window.
2. Enter the field values in the data entry section.
3. Click the "Save" button.

The part will be associated with the vehicle and added to the list.

To update a part:

1. Select the part to update in the Parts list by clicking on the row containing the part you would like to update.
2. Update the field values in the data entry section.
3. Click the "Save" button.

The part will be updated in the list.

**Creating a new service schedule template**

Service schedule templates contain a group of service items which can be used to apply a standard service schedule to multiple vehicles quickly.

To add a service schedule template:

1. Click the "Service" button in the main toolbar.
2. Click the "edit link" text next to the Service template selection list (upper right side of screen).
3. Click the "New" button.
4. Enter a name for the new template you are about to create (eg. Diesel Trucks, Compact Cars, Tractors, etc.)
5. If you would like to begin by modifying an existing template, select it from the drop-down field.
6. Click the "Ok" button.
7. Click the "Close" button.

The new service schedule template will be added to the selection list. You may add service items to the new template by selecting an item on the left and then clicking the right arrow to add it to the template. The default frequency of service will be copied over from the master list of service items. You may change the frequency for each service item in the template, or accept the defaults. After applying a service schedule template to a vehicle, you may also change the frequency for each service item in the vehicle's service schedule, or accept the default values from the template. To apply the new service schedule template to a vehicle, see the topic "Applying a service schedule template to a vehicle ”.

**Managing service items**

The master list of service items is where you manage all of the types of service available in the selection fields throughout Vehicle Manager.

To add a new service item:

1. Click the "Service" button in the main toolbar.
2. Click the "New" button in the data entry area of the Master List of Service Items.
3. Enter a name for the service such as "Change Oil", "Rotate Tires", etc.
4. Set the type (Maintenance, Inspection, or Repair)
5. Set the default maintenance frequency
6. Click the "Save" button to save the new service item.

The item will be added to the master list of service items, and will be available for selection when adding new service log entries. Note: a new service item can also be added directly to the selection list when adding or editing a service log entry.

Managing vendor information

The "All Vendors" list is where you manage the database of vendor information.

To add a new vendor:

1. Click the "Vendors" button in the main toolbar.
2. Click the "New" button in the data entry area of the "All Vendors" list.
3. Enter the vendor information and then click the "Save" button.

The vendor will be added to the list.

Adding company information on reports

The report header can display your company name and logo.

To modify the company information in the report header:

1. Click the "Reports" button in the main toolbar at the top of the window.
2. Click the "Header/Footer" button in the small toolbar located just above the report preview area.
3. Click the "Edit" button to change the header.
4. Add a Company Logo on the Company Logo tab.

The updated information will appear on the reports.

6 Getting More Help

This User Guide provides commonly needed documentation for using Vehicle Manager and can often help resolve questions very quickly. Be sure to check out the Reference section and How To (Steps) section for detailed information about specific areas of the program.

Technical Support and Customer Service is also available via email. You may contact us for additional help using the links below:

Contact Us

For Technical Support:  
http://www.kzsoftware.com/support/index.htm

For Customer Service:  
http://www.kzsoftware.com/contact/index.htm
Reach us by mail at:
Kaizen Software Solutions, LLC
39962 Cedar Blvd. Ste. 323
Newark, CA 94560-5326

7 How To Buy

You may purchase Vehicle Manager online worldwide with any major credit card. Additional purchasing options including Phone, Purchase Orders, Bank Transfers, and Checks are also available through our reseller.

As soon as your transaction is complete, your license key will be emailed to you, and you can enter the license key to continue working where you left off.

Purchasing Links

Direct Order:
http://www.kzsoftware.com/purchase/vehicle_maintenance/index.htm

Additional Purchasing Options
http://www.kzsoftware.com/purchase/options.htm